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User Manual



Thank you for choosing our product. If there are any questions, or requests, please do not hesitate to
contact the dealer.

Disclaimer

@ CAUTION!

The default password is intended for your first login. For security, please set a strong password
after your first login. A strong password shall include at least nine characters comprising all three
types: digits, letters, and special characters. Please keep the password safe and change it regularly.

e Contents of this document are subject to change without prior notice.

e Best effort has been made to verify the integrity and correctness of the contents in this
document, but no statement, information, or recommendation in this manual shall constitute
formal guarantee of any kind, expressed or implied. We shall not be held responsible for any
technical or typographical errors in this manual.

e Theiillustrations in this manual are for reference only.

e Due to uncertainties such as physical environment, discrepancy may exist between the actual
values and reference values provided in this manual. The ultimate right to interpretation resides
in our company.

Conventions

Convention Description

Commands, keywords, parameters and GUI elements such as window, tab,

Boldface font .
dialog box, menu, button, etc.

Italic font Variables for which you supply values.

Separate a series of menu items, for example, Device Management > Add
Device.
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1 Introduction

%

LTS Pro-VS Station is a video management software. It provides video surveillance services including
live view, playback, device management, recording schedule, alarm configuration, video wall, people
counting, and e-map. The software is easy to deploy and operate, suitable for small and medium-size

applications such as for super market, parking lot and residential area. For more details, see
datasheet.

NOTE!

e The software has different versions and shall be installed on a compatible operating system. Please
refer to the datasheet for details.

e Functions may vary depending on factors including but not limited to software version, device and
version, and how the device is managed by the software (i.e., directly connected camera or NVR
connected camera).

e This manual is not intended for a specific software version. Some functions or features described in
this manual may be available to certain version(s) only.

e Directly connected camera: Camera that is directly managed by the software (in comparison with
NVR connected camera).

e NVR connected camera: Camera that is managed by the software via an NVR (in comparison with
directly connected camera).

e IPC: IPC, IP camera and camera refer to the same thing in this manual.
e  PC: The computer that runs the software, also mentioned in this manual as the client.

2 System Requirements

The PC that hosts the software shall meet performance requirements. The requirements may vary,
depending on how you use the software. For example, live view at high resolution in multiple
windows requires higher system performance.

Software Version System Requirements

0S: Microsoft Windows 7/8/10 (64-bit)
64-bit CPU: Intel Core i5 3.1 GHz or higher
Memory: 4 GB or higher

OS: Microsoft Windows 7/8/10 (32-bit or 64-bit)
CPU: Intel Pentium IV 3.0 GHZ or higher (4 Core, 3.0 GHz recommended)
Memory: 2 GB or higher

32-bit

Note: The 64-bit Windows shall be able to host 32-bit software.




Software Version System Requirements

0OS: Mac 0S 10.11 or higher

Mac CPU: Intel Core i5 3.1 GHz or higher

Memory: 4 GB or higher

= NoOTE!
The 64-bit OS and software are recommended. Live view and playback consumes RAM, and the
32-bit software has a relatively small RAM. When RAM is running low, the software will be unable to
play more channels of live or recorded videos, and it will display a message indicating insufficient
RAM.

3 Installation and Startup

1.
2.
3.

Double-click the .exe file, and follow the wizard to complete the installation.
When installation is complete, double-click the shortcut icon to start the software.

Log in with the default username/password (admin/123456).

@ NOTE!

The default password is intended only for the first login. For security, please set a strong password
when logged in (see User Management). A strong password shall include at least nine characters
comprising all three types: digits, letters, and special characters. Please keep the password safe and
change it regularly.

The password for admin (123456 or others) does not change after an upgrade or a reinstall of the
software.

You see the main page when logged in. The main page includes the control panel, some

functional buttons and the system menu.

@ NOTE!

For first time use, a config wizard will guide you to add devices and start live view. The wizard uses
the default username (admin/123456) to add devices.

Click Menu in the top left corner to open the system menu.

The control panel includes the Common and Basic areas. Click an icon to access the
corresponding module. You may drag an icon to change its position with another icon.

The buttons in the top right corner:

lcon Description

m Switch account.




lcon Description

Lock the GUI

Open config wizard, user manual, view version number and update
information.
Note:

If updates are available, you can click to view details and download the
new version.

o The buttons in the bottom left corner:

Icon Description

View realtime alarms, turn on/off alarm sound, enable/disable
alarm-triggered live video.

View alarm triggered live video.

Download recording.

View and manage download tasks.

4 Device Management

Devices include encoding devices, decoding devices, cloud devices, access control devices and
network keyboards. The software supports up to 64 local devices and 64 cloud devices, up to 512
local channels and 512 cloud channels.

Encoding Device

Add an Encoding Device

Encoding devices include IPC (also referred to as IP camera, camera, or video channel in this manual),
Network Video Recorder (NVR) and hybrid NVR.

@ NOTE!

e Managing a device with different management software programs may cause unexpected problems.

e Please always add devices as admin (enter username "admin").

Click Device Management on the control panel and then follow the steps:

1. Click Device > Encoding Device. The page is divided into two areas with two lists:



e Online Device list: The software searches online devices and refreshes automatically. Note: The
discovered devices are not added yet, and you need to add them manually (see step 2).

e Managed Device list: lists devices that have been added to the software.

206.10.241.11

206.

206.

206.10.2.14

206.10.3.240

2. On the Online Device list, select device(s) and then click Add. You may add devices to different
groups.

e The software uses the default username (admin/123456) to add a device. If the password of a
device has been changed and is not 123456, you need to change the password in step 3.

e Inthe Online Device list, you may:
® Click Refresh to refresh the list.

® Click Search Config to specify a network segment to search.

® Click n to select/deselect all the listed devices.

® Right-click a device to visit its Web interface.

3. Onthe Managed Device list, check the status of the added devices and do the following:

To How To

1) Click Add.

2) Choose a mode. The device username (admin) and password are always
required, regardless of the mode you choose.

e |P/Domain: Add a device with a known IP address.
Add device e [P Segment: Add multiple devices with continuous IP addresses.
e MyDDNS: DDNS must be enabled on the device and port mapping must be
completed beforehand. See Appendix for details.
3) Click Add to add to the default group, or Add to Group to add to a specified
group.

Edit Device Select device(s) and then click Edit. This button is especially useful when you




To How To

want to set the same username and password for adding multiple devices.

Select device(s) and then click Delete. The deleted online devices are still on the

Delete device . .
Online Device list.

Sync time Click TimeSync to sync your PC's system time to the selected devices.

) ) Click Status to view device online/offline status, alarm subscription status,
View device recording status, and storage medium status.
status

You may refresh manually or set an interval to refresh automatically.

: Edit device name, IP address, username/password. If the device status
is Offline(incorrect username or password), click this button and change the
password to the actual password. You may also double-click to edit a device.
Use buttons in H

the Operation | e : Configure image, encoding and OSD settings of a device (see Configure
column an Encoding Device).

. E: Visit the Web interface of the device.

. : Restart device.

Configure an Encoding Device

On the Managed Device list, cIickaor an online device to configure image, encoding, OSD and

temperature measurement settings without opening the Web interface of the device.

=/ NOTE!

e This function requires device support and it may be unavailable if the device version is too low.
e Temperature measurement parameters are available to thermal cameras only.
e The configurations displayed may vary with device version and how the device is managed.

e For detailed explanations of image, encoding, OSD and temperature measurement parameters,
please see device user manual.

e  OSD configuration is not available on Mac OS.




Configuration

B Zone

Brightness
Saturation

Contrast

Sharpness

2D Noise Reduction

Image Rotation

Note:

The changed image and OSD settings take effect immediately. Encoding and temperature
measurement settings must be saved first before they take effect.

For an NVR, you need to select a camera from the drop-down list.

When configuring OSD, you can double-click the image to display in full screen; the blue boxes
(Areal, 2 ...) appear only in the preview and do not display on the live view image. You can drag
an OSD to relocate it.

Group Management

You can create groups and manage cameras in different groups.

1.

2.

Add a group.

Device

- -
& Corridor

= Hall

——
= Warehouse

Import cameras to the group.



Import Camera & Edit I Delete £ Configuration

Import Camera

Encoding Device Group

006274 001 IPCam.. & WM

Camera 03 4 @

mera 01 i 003_IP Camera 03

e To import cameras: click the group on the right, select cameras on the left, and then click
Import Selected. To import all cameras, click Import All.
e Toremove a camera from a group, place the mouse pointer on the camera and click Delete.

e Torename a camerain a group, place the mouse pointer on the camera and click Rename.

Decoding Device

You need to add a decoding device before you can use the video wall function. The steps are similar
to adding an encoding device. See Add an Encoding Device for reference.

Note: Add a decoding device as admin.

Cloud Device

|:_& NOTE!
The software can manage up to 64 cloud devices simultaneously, including your own devices and
devices shared from other cloud accounts. If the total number of cloud devices exceeds the limit,
you can click Device Details and use the Add Manage or Cancel button to specify the cloud devices

you want to manage.

Click Device Management on the control panel and then follow the steps.

1. Click Device > Cloud Device.

2. Click Register to sign up for a cloud account; if you already have one, proceed to step 3.

3. Enter your username and password for your cloud account, and then click Login. Devices under
your cloud account are listed, including your cloud devices (under My Cloud Device) and devices
shared from other cloud accounts (under Shared Cloud Device).



cel © TinsSyne

Local Name

Online(bind

61.164.52.189 -
alarm fail)

Operation

Tip:
e Use the buttons under Operation to edit device name, configure image, encoding and OSD
settings, open the Web interface of the device, or restart a device.

e Click Cancel to cancel the management of a device without deleting the device from the cloud
account.

e Click TimeSync to keep a device synchronized with your PC's system time.

e Click Device Details to add, edit, delete cloud devices, to share or cancel sharing, to manage or
cancel management.

Device Details
© Add Manage € Cancel + Add # Edit W Delete * Share [% Sharing Records Status All

Cloud Name Local Name Model IP Address

61.164.52.189 Online

Shared Cloud Device (0 © Add Manage £ Cancel ® Cancel Sharing

Added Jevice Name Model Owner Valid Until

Tips:
e Click Add to add device(s) to your cloud account (the register code required is displayed in the

Web interface of the device; see device user manual for details); click Delete to delete device(s)
from your cloud account.



e Click Add Manage to add device(s) to the software; click Cancel to cancel management without
deleting the device from the cloud account.

e Double-click a device or click Edit to change the device's name. To sync the new name to cloud,
select Sync to Cloud.

e Click Share to share device(s) with another cloud account. Set a sharing period and permissions
as needed. The permissions are pre-configured on the device.

e Click Sharing Records to view sharing history or cancel sharing(s) with other cloud accounts.

e Click Cancel Sharing to cancel sharing(s) from other cloud accounts.

Access Control Device

See Add an Encoding Device for the steps to adding an access control device. Please add access

control devices as admin.

Network Keyboard

A network keyboard can be used to control live video, playback, PTZ camera and sequence resource

on a video wall.

The following steps describe how to play live video on a video wall. Before you start, refer to the

keyboard user manual to connect the keyboard to your PC. And then, click Device Management on

the control panel and follow the steps.

1. Add a camera. On the Camera tab, click Add, select the camera to play on the video wall and
click OK. The camera appears on the list.

Tip: You will use the number (e.g., 130) later when operating the keyboard.

Video Wall Sequence Resource
+ add W Delete
@

Keyboard No.

v lame
20 Addltem B X inStream

®
« v ER ~
@ + ™ 206.10.251.130_002_
& 001

T 206.10.251.120_002_

2. Add avideo wall. On the DX Video Wall tab, click Add, select a video wall and then click OK. You
need to configure video wall first. See Video Wall for details.

Tip: You will use the number (e.g., 1) later when operating the keyboard.



Camera

+ 2dd @) T Delete

Keyboard No.

06.9.252.56

(Ol [ video Wall 1

3. Add a sequence resource. On the Sequence Resource tab, click Add, select a sequence resource
and then click OK. You need to configure sequence resource first. See Sequence Resource for

details.

Tip: You will use the number (e.g., 1) later when operating the keyboard.

+ add || W Delete
©

Keyboard No. Sequence Resouce Operation

Add Ttem o X P

@+~  Warehouse 2

4. The following operations are on the network keyboard.
a. Enter the keyboard number in step 2 (e.g., 1), then press AUX4.
b. Enter the window number in the top left corner (which is 1 in both A and B), then press MON.

c. Enter the split-screen number, then press WIN. If the window is split (as in A), enter the split-screen
number 3; if the window is not split (as in B), enter 1. This step is only required for playing live video
on video wall. For playing sequence resource, skip this step.

d. Select the camera or sequence resource to play on the video wall.
® Live video: Enter the keyboard number in step 1 (e.g., 130), then press CAM.

® Sequence resource: Enter the keyboard number in step 3 (e.g., 1), then press CAM_G.

10



5. After live video starts on the video wall, you can:

e Use the joystick to control the rotation of a PTZ camera, and use the Zoom and Focus buttons to
control the zoom and focus.

e Usethe button to switch live video to recording.

See keyboard user manual for more information.

5 Live View

Live View
Click Live View on the control panel to view live video from cameras.
Play Live Video

1. Onthe Camera tab, double-click a camera or drag it to a window to start live video.

11
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B [T IPC(7/7)
P A Zone
8- ¥ C Zone(6/6)

san NVR(32/62)

8- T2 NVR2(2/3)

8- T2 NVR1(19/33)

s NVR(1/1)

i roup(41/71)

8- :3; Default Group(7/7)
8- ;T2 NVR2(2/3)

= N

2. Right-click a camera to choose a stream type or rename the camera.

3. You may drag the image to play it in another window.

B Esoos

4. Double-click a window to maximize it, and double-click again to restore.

12



After maximizing a window, move your mouse to the left or right side on the live view page, and then

click or I to switch to the live video of previous or next channel.

5. Use the live view toolbar or window toolbar during live view.

Play Live Video by View

By default view

On the View tab, double-click a default view or click Play to start live video from the corresponding
number of cameras on the camera list: 4 cameras for 4-split view, 9 for 9-split view, 16 for 16-split
view, and 25 for 25-split view.

Take 4-Split as an example.

13



s+ [ Default View

Bispit
BB 4-split

_E,'p“t

Live video from the first 4 cameras on the camera list will be played, illustrated as below.

Cam 1 Cam 2

Cam3 | Cam4

By custom view
Play live video from specified cameras by a custom view.

1. On the View tab, click the Add View button to create a view. You may also click View on the
control panel to add a sequence resource.

N
2. Select a window layout. Click to edit a custom layout, use Combine or Undo when editing.

14



Custom

/I@Eﬁﬁ

Edit 9 16 25 36

Default

EID]]EH[QDE@[@Q@

9

[54]

Drag cameras or sequence resources to the intended windows one by one.
Click OK.

Double-click the custom view or click Play to start live video from cameras (specified in step 3)
in the corresponding windows in the layout (set in step 2).

H B Zone

Live View Control

Live View Toolbar

The live view toolbar is at the bottom of the live view window.

=5 & [h 3
Button Description
A Set window layout.

15



Button Description
B Save the current view directly or as another view.
C Close all windows playing video.
D Snapshot all.
E Start recording of all windows playing.
F Stop recording of all windows playing.
G Pause/resume sequence display
H/I Play the previous/next group or view in sequence display.
J Switch to full screen mode. Press Esc to exit.

Live View Window Toolbar

The window toolbar appears when you place the mouse pointer on a live view window. The toolbar

is effective only to the current window.

(AXBXCXDXEXF) ©

Main(5.97Mbps,

Button Description

A Take a snapshot. The snapshot format and storage path are configurable in Client
Configuration.

8 Records live video playing in current window to the PC.
The video format and storage path are configurable in Client Configuration.

c Digital zoom. When enabled, drag the mouse to draw an area on the image to zoom
in on, and use the scroll wheel to zoom in or out.

D Adjusts the speaker volume or mute it for the PC.

E Two-way audio.
Starts instant playback. Plays back the live video playing in the current window for

F the last 5 minutes and 30 seconds. The playback pauses at the end, and you need to
start live video manually.

G Stream type, bit rate and resolution of the current video.

16



@ NOTE!

e The toolbar shows n when the camera is a PTZ camera. Click this button to open the PTZ control

panel.

e The toolbar showszhen the camera is a fisheye camera. Click this button to open the fisheye
control panel.

[=<H
e The toolbar shows when the camera is a multi-sensor camera. Click this button to enable
tracking mode.

Live View Shortcut Menu

A shortcut menu appears when you right-click a live view window. Some items on the menu provide

same functions as the live view toolbar and window toolbar. Some are described in the table below.

Parameter

Description

Stream Type

Select a stream type for the current window: auto, main, sub and third stream
(options may vary with device).

Note:

Sub Stream and Third Stream are not displayed if not available.

Manual Alarm

Trigger an alarm manually.

Note:

It is recommended that you first configure the action(s) to trigger (see
Confiqure Alarm-Triggered Action). A click of this button will generate an alarm
and trigger the configured action(s).

Display frame rate, resolution, bit rate, video compression format, and packet

Camera Info loss rate for the window.
Play Local | Open the folder containing local recordings on your PC and play in the current
Recording window.

@ NOTE!

The default stream type is auto.

e For local devices, the client chooses a stream type according to the screen layout.

e 4 windows or less: Main stream
e 4 to 16 windows(16 included): Sub stream
e More than 16 windows: Third stream

e For cloud devices, the default is third stream.

PTZ Control

Control the rotation direction and speed, pan/tilt/zoom, focus of a PTZ camera. The software also

provides other functions including 3D positioning, preset, and patrol functions.
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@ NOTE!

PTZ control is available to PTZ cameras only and it may vary depending on the camera's capability
and the protocol it supports. For example, some manufacturers reserve certain presets for special
use such as wiper or menu. Please refer to camera specifications before use.

PTZ Control Panel

Click n on the live view window toolbar to open the PTZ control panel, which can fold and expand.

You can also move the control panel to the left by clicking .

Parameter Description

Control rotation direction or stop rotation.
Tip:

e You may also use shortcut PTZ control to rotate the camera: place
the mouse pointer on the live view window, and when the shape
changes to like ’, click and hold the left button to rotate the
camera.

e You can enable or disable Shortcut PTZ Control under Client
Configuration > Audio & Video

e Shortcut PTZ control is not effective when 3D positioning is enabled.

Adjust focus and zoom.

e Control the light.

e Control the wiper.

e Control the IR.

e Control the heater.

e Control the snow removal function.

Adjust rotation speed.
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Parameter Description

Click the tab to enable/disable 3D positioning. With 3D positioning
enabled:

=1
& e Click somewhere on the image, and the camera automatically rotates
toward the direction.

e Drag the mouse from top to bottom to zoom in on the selected area.
Drag from bottom to top to zoom out.

Preset tab.

Patrol tab.
Lo |

Auto Guard tab.

Preset

Add a preset to save the status of a PTZ camera. When needed, you can rotate the camera to the
previously set position with one click of the button. Presets are also used to set a preset patrol (see
Preset Patrol).

1. Rotate the camera to the desired direction.

2. On the Preset tab, click Add Preset. Enter a preset number that is not in use; otherwise, the
existing preset will be replaced by the new preset.

Preset Patrol

The camera patrols along multiple presets in the set order and stays at each preset for certain length
of time. Because a preset patrol route consists of presets, you need to add all the needed presets
first (see Preset).

1. On the Patrol tab, click Set Patrol.
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Route Number 1 e | Warehouse 4 ew Preset

+ Add W Delete T & Down & Botton

Operation

2. Click Add, select a preset, and set the length of time that the camera stays at this position.
Repeat this step to all the necessary presets.

3. Use the Set Top, Up, Down, Set Bottom buttons to adjust the order in which the camera
patrols.

4. Click Save.

5. The patrol route appears in the patrol route list. Click Start Patrol, and the camera will patrol
along the presets that you have set.

Recorded Patrol

The user operates the camera, and meanwhile the software records the movement track and status
of the camera and saves it as a patrol route. Currently one recorded patrol route is supported.

AP o

O[Recorded Patrol =

» B +

1. Click Start Recording Patrol Route.

2. Use the directional buttons or shortcut PTZ control to rotate the camera to desired directions
and stay for the intended length of time. Adjust zoom and focus as needed.
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3.

4,

Click Stop Recording Patrol Route. The recorded patrol route appears in the patrol route list (by
the name O[Recorded Patrol]).

Click Start Patrol. The camera will repeat the actions you performed during the patrol.

Auto Guard

After auto guard is enabled, the camera performs the action (start patrol or go to the preset) as
configured if no operation is made during the specified time period.

Auto Guard

futo Guard Enahble Dizahle
Made Freset

Preset 1[1]

Idle Statels) & [1—z600]

Fisheye Control

Fisheye control, set mount mode and display mode to get desired images:

Mount: Ceiling, Wall, Desktop

Display Mode: Original Image, 360° Panoramic+1PTZ, 180° Panoramic, Fisheye+3PTZ,
Fisheye+4PTZ, 360° Panoramic+6PTZ, Fisheye+8PTZ, Panoramic, Panoramic+3PTZ,
Panoramic+4PTZ, Panoramic+8PTZ (clicking Original Image switches from dewarping mode to
normal mode).

NOTE!

The fisheye control button is available to fisheye cameras only.

In dewarping mode, you may click a PTZ window and then use the mouse to drag the image, or
zoom in/out using the scroll wheel; or click a panoramic window and then drag, zoom in or out on
the demarcation area.

Digital zoom is disabled in dewarping mode, and the digital zoom button is hidden. If you switch to
dewarping mode when digital zoom is enabled, digital zoom will be disabled automatically, and the
image restores its original size.

Dewarping mode is not available when resolution is below than D1, and the fisheye control button is
grayed out.

Fisheye control is not available on Mac OS.
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Tracking Mode

In tracking mode, if you play main stream of the multi-sensor camera, the camera will automatically
track the objects that trigger the set alarm rule.

1. Click in the live view or playback window toolbar. The window is split into multiple
windows: one big window showing the panoramic image, and multiple small windows showing
PTZ images. The boxes on the panoramic image match the PTZ images.

2. Perform the following operations as needed:

e Draga box in the panoramic image to change the range of the corresponding PTZ image.

e Scroll your mouse wheel on a box or a PTZ image to zoom in or out.

= NoOTE!
e To use auto tracking function, you need to enable perimeter protection function for the camera
first.
e Enabling tracking mode will disable digital zoom.
e Tracking mode is not available on Mac OS.

Sequence Display

Sequence Resource

Play live video from cameras in a group one by one in a window. First, you need to create a sequence
resource.

Create a sequence resource

1. On the Live View page, click the Sequence Resource tab, and then click the Add button. You
may also click Sequence Resource on the control panel to add a sequence resource.

2. Complete settings in the window, including sequence resource name, sequence interval, video
channels to include, stream type, preset (PTZ camera). Click the Top, Up, Down and Bottom
buttons to adjust the sequence as needed.
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ce Info

Warehouse

Channel Hame

B Zone

A Zone

™5 Zone
™5 Zone

3. Click OK.
Play a sequence resource

Double-click the sequence resource on the Sequence Resource tab to start sequence display.

Sequence View

Sequence a default view
Play live video from cameras on the camera list in sequence based on a default view.

1. On the View tab, click the Sequence Display button for a split view. Take 4-Split view for
example.
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» [ Custom View

2. Setsequence display interval.

3. Assume there are eight cameras, and the sequence interval is set to 20 seconds. Then the
sequence is illustrated as shown below.

Cam1l | Cam?2 Cam5 | Cam 6 Cam1 Cam 2
20s 20s

Cam3 | Cam4 Cam7 | Cam8 Cam3]| Cam4

Sequence custom views
Play live video by custom views in sequence.

1. To create a custom view, click Add View.

+ [ Default View
B 1-spiit

== 4-5p|it

s view

2. Complete the settings in the window, including the view name, window layout, binding between
the cameras/sequence resources and the windows (by dragging the cameras/sequence
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resources to the windows or by clicking Batch Add), stream type (for cameras only) and preset
(for PTZ cameras only). Click OK when you complete the settings.

¥iew Info

Hame Factory

Video Chanmel

[ HH B HE

Channel Name Stream

A Zone

3. Repeat the above steps to create all the custom views you need.

4. Click the Sequence Display button to sequence the custom views you have created.

[l Custom \!"

Sequence Display

6 Recording and Playback

Record videos and search for playback or download.

Configure a Recording Schedule

Configure a recording schedule for an NVR to record video automatically. This function is available to
NVR-connected cameras only. The recorded videos are saved on the NVR, not on the PC.

Click Recording Schedule on the control panel and then follow the steps.
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Configure a 24/7 Recording Schedule
Use the template to configure a 24/7 recording schedule.

Select i

0 2 4 3 10 12 14 16 18 20 22

L ! | | . | | ' | | | | | | | | | | | | | | | | | ]
2y S I I Y S S S S S S S N B
rsclay NN I I I S S S N
L. ' ' ' ' ' ' ! ' ' ' | | | | | | | | | | | | | | | | | | | | | | | ]
L. ' ' ' ' ' ! ! ' ! | | | | | | | | | | | | | | | | | | | | | | | | ]
L. ' ' ' ' ' ' ' ' | | | | | | | | | | | | | | | | | | | | | | ]

Select the camera for which you want to configure a recording schedule.
2. Make sure the Enable check box is selected.

3. Click the Select button and then select the All Day template. The green on the calendar means
time periods during which video will be recorded.

4. Click Save.

Customize a Recording Schedule

Customize based on the 24/7 recording schedule.

1. Click or drag on the green to erase, or click or drag on blank areas to draw. Clicking the Clear
button in the top right corner will clear all time periods.

2. In addition to the method described in step 1, you may also enter start and end times manually.
Up to 8 time periods are allowed for each day.
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3. After you complete the settings for a day, you may select from the drop-down list and copy the
settings to other days. For example, select All.

4. Click Save to complete the configuration for the selected camera.

To make the same recording schedule for other cameras, click Copy To.

2 NoOTE!
In addition to the All Day and Work Day templates, you may customize 8 templates to save
different recording schedules.

Record Video Manually

Save live video to your PC as local recording by clicking the Start Local Recording (@) and Stop Local

Recording (I&) buttons on the window toolbar. The storage path and video format are configured in

Client Configuration.
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Playback

Click Playback on the control panel to search and play recordings, including device recordings and

local recordings.

Play Device Recordings

Device recordings refer to videos stored on an NVR or an SD card that is mounted on a camera.
When you search for device recordings, the time displayed is same with the system time of the
device, not your PC. The GUI and operations may vary with the playback type you choose. We take
Normal Recording Playback for example to describe the general procedure.
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Description

1) Select the source of recording (device recording).

222 1PC(7/7)
¥ A Zone
™ C Zone(6/6) 3) Select the camera(s).

8:[_1<2 NVRG1/62) 4) Select or set the search time. If the device is in another time zone,
il please use the local time of the device.

2) Select the playback type.

U8206.10.251.131_001 L.

B v 81 70ne 5) Click Search.
,206.10.251.13L017>12 Note:

. NVR1(19/33)

e In step 2, you may select a sub type to search for event recordings or
VCA recordings.

e In step 3, up to 16 cameras are supported if multiple selections are
allowed.

e In step 4: The calendar shows search results for the selected
camera(s) (blue means normal recording, and red means alarm
recording). This feature is only available to Normal Recording
Playback and Smart Recording Playback modes.

BB NVR(1/1)
Search Time

2018

Play Local Recording and Image

Search and play videos and images saved on your PC. The time of local recordings is the time of your
PC.
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Step Description

1) Select the source of recording (local recording).
2) Select the camera(s).
3) Select or set the search time.

4) Choose to search for recordings or pictures. The default is to search
for recordings.
5) Click Search.

Search Time Note:
2020 Apr
o T e :. B | /n step 3: The calendar shows search results for the selected camera(s),
1 1 2 3 and blue indicates recording on that day.

O \Il 10
14 5 16 7
21

8 29

Re::-rdin;@ Picture

®) Search

Playback Control

Double-click a file on the right-side list to start playback; or click on the timeline to start playback
from the corresponding time.
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Playback Toolbar

Button Description

A Set window layout.

B Close all windows.

C Click to take a snapshot of images in all windows.
Click to switch to synchronous playback mode. In synchronous playback mode,
operations (e.g., pause, resume, stop, adjust speed, click on the timeline to start
playing from that point) are effective to all the playing windows.

D
Note:
Frequent operations (such as pause/resume, adjust speed) during synchronous
playback may affect the synchronous performance.

E/H Play by frame. Click to play the previous/next frame of image.

F Pause/resume.

G Stop

I Adjust playback speed.

J Download recordings.

K Switch to full screen mode. Press Esc to exit.

L/N Move the timeline forward or backward.

M Zoom in or out on the timeline.
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Button Description

(0] Click to open a calendar and search recordings of a different date.

Playback Window Toolbar

The window toolbar appears when the mouse pointer rests on a playing window. Operations with
the toolbar are for this window only.

A XEYCRD e

(97 7kbps, 1280x720)

Table 6-1 Playback Window Toolbar

Button Description

A Take a snapshot and save it to your PC. The image format and storage path is
configurable in client configuration (see Client Configuration).

B Digital zoom. When enabled, drag the mouse to draw an area on the image to zoom in
on, and use the scroll wheel to zoom in or out.

C Clip the video to download.

D Mute or adjust speaker sound volume on your PC.

E Current bit rate and resolution.

@ NOTE!

e The toolbar showszhen the camera is a fisheye camera. Click this button to open the fisheye
control panel.

e The toolbar shows when the camera is a multi-sensor camera. Click this button to enable
tracking mode.

e You can choose a stream transmission protocol (see Client Configuration) according to the network
environment to improve image quality.

Right-click Menu

A menu appears when you right-click a window during playback. Many functions on the menu are
same to the toolbar buttons.

Playback by View

In normal recording playback mode, playback by view can play recordings of cameras bound to the
windows in the set window layout. On the View tab, select a custom view, select a date on the
calendar, and then click Search.

This function is only available to device recording.
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Smart Search

The NVR records motion in different areas of the image when recording video. Smart search allows

you to locate videos that include motion in the image.

@ NOTE!

This function is available only when the software works with certain NVR models and versions.

1. On the Device tab, select Smart Recording Playback from the drop-down list. Select a camera,
and then select a date on the calendar.

2. Search results appear on the timeline. The green means videos with changed images, and the
green part plays at the normal speed; other irrelevant parts play at high speed.

2018-09-06 00:11:12

3. By default, smart search searches the entire screen. You may click the Draw Area button (A) and
then drag or click to edit the search area (covered by red grid).
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2018-09-06 00:11:47

4. Click the Finish Drawing button (B), adjust search sensitivity as needed, and then click the
Search button (C) to search again.

Recording Download

Download Recordings

Use the following methods to download recordings from a device to your PC. Download progress
displays in real time on the bottom toolbar.

e After a search, click the Download button () under the recording list (see Playback
Toolbar).

e Use the Start Clipping and Stop Clipping buttons on the window toolbar (see Playback Window
Toolbar).

e Use the right-click menu.

e Click the Recording Download button () in the lower left corner of the GUI, search device

recordings and then download recording files. You can also download the recordings by time.

Manage Download Tasks

1. Click the Task Management button (E) in the lower left corner of the GUI to manage
download tasks.

2. On the Recording Download tab, view and manage download tasks. The operations for the
tasks vary with download status. You can stop download tasks, delete tasks, resume tasks, play
downloaded recordings, and open a folder to view the downloaded recordings.

34



Task Management

Batch Configuration

Downloading (1) Stop Download

File Name Start and End Time Download Progress

Operation

0%
Completed (0) Downloading

@ NOTE!

e Stopping a download task does not delete the video that's already downloaded to your PC.
e You may set the file format and path at Client Configuration > Audio & Video > Recording.
e Avideo player is needed to play the downloaded recordings.

7 Video Wall

Play video on a physical video wall.

Video wall is divided into DX video wall and decoding card video wall, depending on the device used
to create the video wall.

e DXvideo wall: Video wall created by using a decoding device.
e Decoding card video wall: Video wall created using a decoding card on an NVR.
2 NoTE!

e Add a decoding device or an NVR as admin first under Device Management > Device.

e The number of video walls supported, operations allowed, and functions/features available may
vary with decoding device and version.

Add a Video Wall

Click Video Wall on the control panel. For the first time use, click and then choose a

video wall type. If a video wall already exists, click right to the video wall name to add a video

wall.

35



+ Auto-Bind Channel

Enter the video wall name.

2. Select the decoding device you want to use to create the video wall. The software automatically
sets the video wall size and binds decoding channels to the windows. Decoding channel names
appear on the screen.

3. Edit the video wall size, resolution or the binding between the decoding channels and windows.
Use the Unbind All ( ) ) or Bind All ( 'E) button as needed.

4. Click OK.
Note:
e Make sure the video wall size is consistent with the physical video wall.

e Set small pixel pitch LED if necessary. The special LED width is the width of the last column; the
special LED height is the height of the last row. The unit is pixel.

5. To edit or delete a video wall, click n next to the video wall name.

Video Wall Operations

Play Video on Video Wall

Before playing video on a video wall, you can place the mouse pointer on E after an online camera

to preview live video.

1. Drag cameras to windows to start live video on the video wall.
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@ NOTE!

Some video walls require you to open window(s) on the screen first. The functions available may
vary depending on the actual video wall, for example, you may open a window manually by
dragging on the screen, automatically by choosing an existing layout, or by setting coordinates and
window size.

Screen Control

NO.1 Vide...

P Camera 02
)6_[P Camera 06

P Camera 07

206 P Cameral9

L G roup(9/12)

Tip: To start live video from multiple cameras or group(s), select the cameras or group(s), click a
window and then click Play on Screen or Play on Wall.

e Play on Screen: Play on one window.
e Play on Wall: Play on multiple windows.

2. To play a signal source (such as from a PC), click the Signal Source tab, and then drag the signal
source to the intended window.

3. To choose a window to play alarm-triggered live video, right-click the window and click Set
Alarming Window. Make sure alarm-triggered live video is configured (see Configure
Alarm-Triggered Action for details). To cancel the setting, right-click the window and click
Cancel Alarming Window.

@ NOTE!

e Only one window can be set as the alarming window.

e If the video wall is created using an NVR's decoding card, alarm-triggered live video is only available
to a camera under the NVR.

Output Audio

Use the audio output channel of a DX device to output audio of a camera playing in a window or a
screen. Only DX video wall created with certain DX device models supports this feature.
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1. Click m (1), and then select the audio channel.

2. Click a window/screen, and then cIick“(z); or right-click and then select Audio. An icon

appears in the top right corner, means the audio channel is outputting audio of the IPC in the
window/screen.

3. Adjust output volume or mute the sound as needed.

Play Sequence Resource

Play sequence resources on video wall. Three sequence modes are available: sequence video on a
single window, sequence video on multiple windows, and sequence scenes.
Sequence on Single Window
On the Sequence Resource tab, drag a sequence resource to a window.
Sequence on Multiple Windows
On the Sequence Resource tab, select the sequence resource, click Play on Screen, and then select

the windows.
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NO.1 Vide.. A Check All
Z & X

Cancel

Sequence Scenes

Scene refers to video wall settings including screen layout, window, and video service (live view or
sequence). The scene allows you to recall the video wall settings with one click of a button. Sequence
scenes is to display different scenes according to set time.

1. Click E or click on the Scene tab to create scenes.

Scene Info

Cancel

Screen Control

3. Select the scenes and import them to the plan.
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v ool

4. Set the sequence mode. You may choose to sequence by time interval or configure a 24-hour
sequence plan.

e Sequence by interval: Display scenes one by one at set intervals, for example, 30 seconds in the
figure above.

e 24-hour plan: Enable the plan, and then set the starting time. The scene will automatically
display on the video wall at the set time. You may add scenes repeatedly as needed.
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Scene Sequence Plan

Plan Mame Hall & Corridor Sequence By ) 24H Plan

W Delete Down Bottom

Scene Name Start Time

v | [E1] Hall
v Corridor

Meeting Room

Corridor 08:00:00
Hall 14:00:00
Corridor 20:00:00

Hall 02:00:00

Remarks

Cancel

5. The scene sequence plan appears on the Scene Plan tab. Click Start to start scene sequence.

(=41 Corridor&Hall

Other Video Wall Operations

For more video wall operations, see the tables below.

006 © 006
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The buttons on the toolbar are effective to all windows on the video wall.

No. Description
A Save scene. See Sequence Scenes for details.
B Splice screens (combine several screens to make one bigger screen).
C Start decoding in all windows.
D Stop decoding in all windows.
£ Click ':]o renumber all windows according to their positions: from top to bottom, from left
to right.

Channel Name

A Zone

000 O
®

Hindow

Window control area. Buttons in this area are effective to a selected window.

No. Description
F Split a screen.
G Start decoding.
H Stop decoding.

I Display a window in full screen mode.

J/K/L Current camera, stream type, and preset (PTZ camera only).
M Search and play recordings.
N Display/hide the window control area.

The following features may also be available on a DX video wall:

e Virtual LED. You can overlay text on video wall windows and set the background, customize text
content, size, color, space, alighnment, transparency, and scrolling.

&Z
. .: When multiple windows overlap, the selected window appears on the top by default. To

set a window to appear at the bottom, click this button (or right-click the window and then
choose from the shortcut menu).

. ﬂ: Lock the position and shape of a window (or right-click the window and choose from the

shortcut menu). Click ﬂ to unlock.
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. H: Click this button to expand the selected window to full screen (or right-click the window

kT4
and choose from the shortcut menu). Click to restore.

e View window info: Right-click a window or screen and choose Window Info to view information
such as window ID, split screen ID, stream status, etc.
e For certain DX video walls, you can double-click a window to magnify it, and double-click again

to restore.

Screen Control

On the Screen Control tab, you can turn on/off screens including small pixel pitch LED screens.
Before you operate on the client, make sure the screen, the power distribution box (for LED screen),

and the server are properly connected.

Configure Serial Port and Protocol

Configure the serial port and protocol in accordance with the decoding device model and screen

type.

Serial Port

COomM1
Protocol
LA
Turn On/Off Screen Automatically
Turn On At

Turn Off At

Turn Off In min(s)
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Turn On or Off the Screen Automatically at a Set Time

1. Select Turn On At or Turn Off At, and then set the time(s) when the screen automatically turns
on or off.

2. Click Save. The screen will turn on or off automatically at the set time.

Turn On or Off the Screen Manually

1. Click Turn On Screen. The screen turns on immediately.

2. Click Turn Off Screen. The screen turns off immediately.

Turn Off the Screen with Delay

1. Select the check box for Turn Off In and then enter the time in the text box.
2. Click Turn Off Screen.

3. A message as shown below appears. The screen turns off automatically when the timer expires.

.' A timer has been set. -

8 Behavior Search

Search VCA images and recordings from an NVR.

@ NOTE!

This feature is available on certain NVR devices/versions. Currently this feature only supports Cross
Line Detection and Intrusion Detection.

1. Follow the steps as illustrated on the image.
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2. Perform the following operations as needed.
e Play or download the alarm video (5). The alarm video is 10 seconds long (5s before and 5s after
the alarm time).

e View or save the alarm image (6). You can click the left or right arrow to view the previous or

next image.
e Click (7) to switch to list mode.

e Click (8) to export search results.

9 Face Recognition

View live video, alarm records and pass-through records; manage device face libraries and
monitoring tasks. Use face recognition to search people and count people coming in and out.

Realtime Monitoring

View live video and snapshots of people passing through, view realtime alarm records.

Double-click a camera to start live video. Up to four cameras are allowed.
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Video Channel

® 1ot 279 o M 26¢ Abnormal Temperature Clear Statistics

Ma:

A1l Cameras

\

Ho mask
1

\

No mask 37.40°C

Perform the following operations as needed:

e Click a snapshot to view details. Click More to go to the Pass-Thru Records tab. If a face is
identified as a stranger, you can add it to a face library: put your mouse pointer on the snapshot,

click Loj, enter the required information, and choose the target library.

Snapshots

-

&

\

- _= ;
Ho mask No mask 37.40°C

192. 16°-* 192. 16-*

03:52:33 03:52:33

e View realtime alarms. Click More to go to the Alarm Records tab.
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Comparison Record

Ml Cameras

A

=8

Hot Matcl

a. Choose a record type:

®  Comparison Record: Click an icon to filter alarm records by comparison result (

match, for not match).

® Mask&Temperature Records: View records of people not wearing a mask and people
with an abnormal temperature.

Comparison Record

1] Cameras

b. Click a record to view the corresponding face comparison information. Personal
information is displayed only when the degree of match between the captured face and the
face in the library reaches the set alarm threshold. See Monitoring Task for details.

e View people counting statistics. The statistics are displayed only when Mask&Temperature
Record is chosen.

To view the statistics of people not wearing a mask and people with an abnormal temperature,
you need to enable Mask Detection and Abnormal Temperature Detection first. See Client

Configuration for details. The statistics are automatically cleared at 0:00 every day. You can also
click Clear Statistics to reset the statistics manually.

® 1otal 667 FoMask: 35 Abnormal Temperature: Clear Statistics

e Configure epidemic control parameters. CIickunder the live view window to configure

epidemic control parameters. See Client Configuration for details.
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e Configure attributes to be displayed for match faces and not match faces. CIick under the

live view window to configure attributes. See Client Configuration for details.

@ NOTE!

A device reports alarms only when a corresponding monitoring task has been configured.

Face Library Management

Manage faces in different libraries to meet different monitoring needs. The libraries are saved on the
device.

Create Face Library

Select the device you want to manage, then the face libraries of the device appear in the list. Click

to create a new face library. You can edit the library name or delete a library you don’t need

anymore.

Face Library

206.3.0.66

« [l 206.2.0.66(2/16)

Bl Regulars(15) & W
Bvire) & o

Add Face Data

Choose one of the following ways to add face data to face libraries.
Option 1: Use Batch Add

1. Click Batch Add, then select the target face library. You may select multiple libraries of different
devices.

2. Click Add, then select face images you want to add. The images must be JPG files and the size of
each photo is between 10KB and 500KB.

3. Click the edit button, enter the required information.
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Batch Add

Select All | = Add

Name
Gender  Male Female ® Unidentified Nationality
<Name=

<ID No.> ID Type ID Card Province

ID No. City

Cancel

4. Click Next to save and continue to the next, or click Finish.
5. Click OK when you complete the information for all.
Option 2: Import a file containing face data

Import a file that contains the necessary face data. The file and its content must conform to the
format, and the size of each photo is between 10KB and 500KB.

1. Click Download Template and then enter the face data into the template file.

2. Click Import and select the file you have edited. The imported data appear in the list. You can
click the button in the list's upper right corner to switch display mode.

SelectAll =+ BatchAdd T Delete i Import [® Export ¥ Download Template

FIRNNON

John Va [ Micky Va i Shelley Alan Vi W Frank Vi i Amy Vi I} May

3. Edit or delete face data as you need; click Export to save the face data in the current library to a
CsV file.
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Monitoring Task

Create monitoring tasks using the created face libraries. The device compares the captured faces
with the faces in the libraries and reports alarms as configured.

1. Select a camera on the left, and click Add to create a monitoring task.

2. Set the task name, monitoring type, and choose a face library to be used for monitoring. Set the
alarm threshold based on your needs.

e Match Alarm: If the similarity (or Match in Realtime Monitoring) between a captured face and a
face in the library reaches the alarm threshold, the device reports a Match alarm.

e Not Match Alarm: If the similarity between a captured face and a face in the library fails to
reach the alarm threshold, the device reports a Not Match alarm.

e All: To monitor all the faces that the device captures.

Add Moni toring Task

Tazk Hame

Monitoring Type A1l1

#larm Threshold ®

Remarls

=/ NOTE!

Personal information such as name and ID number will not be displayed in the realtime monitoring
window for a Not Match alarm.

3. Click OK. The task is created and appears in the list. For an NVR channel, you may copy the
monitoring task to other channels of the same NVR.

Operation

Alarm Records

View alarm records generated by the configured monitoring tasks.

Choose a video channel, set search conditions including monitoring type and alarm time, and then
click Search. If you chose Match Alarm as the monitoring type, you can click More to set more
conditions including name, ID number, degree of match, mask wearing status, and body temperature
range.
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NOTE!

Only NVR channels supporting face detection or face recognition can be selected.

Perform the following operations as needed:

e Add the face snapshot of a stranger to a face library

Put your mouse pointer on the face snapshot and then cIickLe. You need to enter the required

information including name and ID number and specify the target library.
e View details

Click a record to view alarm details.

e Exportrecords

Click Export to export all the search results.

Pass-Thru Records

View pass-through records, people counting statistics, mask wearing status, body temperatures.

Choose a video channel, set search conditions including alarm time, mask wearing status and

temperature range, and click Search.

NOTE!

Only NVR channels supporting face detection or face recognition can be selected.

Perform the following operations as needed:

e Add a stranger’s face snapshot to a face library

Put your mouse pointer on the face snapshot and cIickLo. You need to enter the required
information including name and ID number and specify the target library.

e View details

Click a record to view alarm details.

e Export records

Click Export to export all the search results.
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10 People Counting

Count people entered and/or left during a certain period.

=/ NOTE!

This function requires that the camera be capable of people counting and connected to the PC via
an NVR.

Click People Counting on the control panel. The People Counting page is displayed with two tabs:

e Realtime Statistics: Display counting results of selected cameras in real time, including seven
latest counting results.

e Report Statistics: Display counting results in a bar chart or a line chart and export.

Realtime Statistics

On the Realtime Statistics tab, select the check box for the camera to enable realtime statistics. You
may double-click a camera to start live video from it.

e Enable realtime statistics to view real-time counting results from selected cameras.

Statistics include:

e Realtime counting results (left side): It is the total number if multiple cameras are selected. The
three colors indicate different counting types, and they match the lines on the coordinates on
the right side.

e 7 latest counting results (right side): axis X means time, and axis Y means number of people (the
minimum is 0; the maximum is 10 by default and it updates according to the actual counting
result).

When realtime statistics is enabled, the first time of counting is displayed in the lower left corner of

axis X (1), and the counting result appears on axis Y (e.g., 993). The result updates periodically, and

the latest result is displayed on the right (2).

@ NOTE!

Live view and realtime statistics stop automatically when you close the People Counting page or
log out of the system.
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Report Statistics

On the Report Statistics tab, select camera(s) and then click on _ to count

directly; or set conditions first:
e Counting type: By minute, hour, day or month.

e Setatime period by selecting on the calendar or typing in the field.

Count people entered and/or left by selecting the check box(es) .

Display results in a line chart or a bar chart by cIicking[.

NOTE!

The maximum time period you can set is 60 time units, depending on the counting type (minute,
hour, day or month) you choose. For example, the maximum period is 60 months if you choose to
count by month, and 60 days if you choose to count by day.

%

Click Count, and results appear.
e Place the cursor on the line/column to view the number at a time point.

e Click a column title, for example, People Entered or People Left to sort the results in ascending
or descending order.

[# Bxpert

Channel Name Statistics Time People Entered People Left

206.9.252.17 023 2018/09/04 0 0

206.9.252.17_023 2018/09/05 038 319

194

Click to display in a bar chart.
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09/04 09/08

Channel Name Statistics Time Peaple Entered

206.9.252.17 023 2018/09/04 0

206.9.252.17 023 20 /0 1038

206.9.252.17 023 2018/09/06 824

Click Export to export statistics as a CSV file to your PC. You can use Microsoft Office Excel to open
the file.

1 1 Access Control

Manage access control libraries, perform realtime monitoring, search and export entry/exit records.

Library Management

Add a Library

Add a library for an access control device and use the library to control access.

1. Choose the target access control device in the drop-down list on the left.

2. Click behind the device name. A new library appears under the device.

3. Click n behind the new library, and enter the device name.

4. Click OK.

Add Personal Data

Add personal data to the library. You can add data for one person at a time, for multiple person using
the Batch Add feature, or for multiple persons at a time by importing a file containing personal data
of these persons.

Option 1: Add data for one person
1. Click Add > Add One Person.
2.  Enter the required information. Click the image on the left to upload a photo.

3.  Click Next Step, and choose the target library.
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4. Click OK.

Option 2: Use batch add

1. Click Add > Batch Add, and choose the target library.
2. Click OK.

Select All =+ Add I Delete

ID Type
ID No.

Remarks

Finish

3.  Click Add, and select face image(s) you want to add.

4, Click E, and enter required information including name and ID.

5. Click Next to save and continue to the next, or click Finish.
6.  Click OK when you complete the information for all.

Option 3: Add data for multiple persons at a time by importing a file containing personal data of
these persons

1. Click Generate Template, and use the template to create a file containing the required personal
data.

2. Click Import, and select the target library.

Bro
3. Click , and select the file to import (CSV or XLSX).

4. Click Import.

=/ NOTE!
e Only JPG images are allowed. The size of each image must be within the range of 10KB and 500KB.

e  XLSXfiles cannot be imported or exported on Mac OS.

The following operations are allowed:

. Click ED in the list's upper right corner to switch display mode.
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. Click Export to save data in the library to a CSV or an XLSX file.

Realtime Monitoring

View live video and snapshots of people passing through, take snapshots, use digital zoom, and open
the door remotely.

Double-click a camera or drag it to the window to start live video. Pass-through records are displayed
on the right side.

Video Channel

- ;33 ACCESS(2/2)

P2D21.192.1682213

™ D21.192.168.2.214

OB

The captured face snapshots and the corresponding library photos (if a match is found) are displayed
on the right side. You can click a record to view details, including the original snapshot, mask wearing
status and body temperature.

Fass—Thru Details
Library Fhoto
Ho
ID Ho.

IC Card Ho

Remarks

Show Original Snapshot

If a face snapshot does not have a match in the library, then no library photo is displayed, and the
person will be identified as a strange. You can add the stranger to a library by placing your mouse
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pointer on the face snapshot and clicking . You need to enter a name and ID for the person and
specify the target library.

@ NOTE!

e Mask detection and temperature detection are available only when they are supported by the
device and have been configured on the device. See the user manual of the access control device
for details.

e If the access control device can upload original snapshots, the Show Original Snapshot button will
be displayed, and you can click it to view the original snapshot.

e Up to 10 pass-through records can be displayed. The oldest record will be replaced by the new one
when more than ten pass-through records are generated.

e Pass-through records are displayed in real time. Restarting the software will clear the pass-through
records in realtime monitoring.

e You are recommended to configure at least one library before you view pass-through records.

The following operations are allowed:
. Live view window toolbar

The window toolbar appears when the mouse pointer rests on a live view window. The toolbar is

effective only to the current window. See Live View Window Toolbar for details. Theon the

toolbar is used to open doors.
. Live view toolbar

See Live View Toolbar for details.

. Client configuration

Click E in the upper right corner to configure alarm sound, pop-up alarm window, etc. See Client
Configuration for details.

Entry/Exit Records

Search entry and exit records by time, mask wearing status, body temperature range, authentication

result, etc. You can further filter search results by name and IC card number after setting
Authentication Result to Succeeded.

The following operations are allowed:

. Add a stranger to a library quickly
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The library photo is empty when a stranger is detected. To add the stranger to a library, cIick in

the Operation column, enter the required information including name and person ID, click Next Step,
and then select the target library.

. View details

Click in the Operation column to view detailed personal information.

. Export search results

Click Export to save search results to a CSV or an XLSX file. You can choose to export only text or both
text and images.

12 E-map

First complete configuration on the Edit Map tab, and then use the map on the Map tab.

e Hot spot: Video channels, alarm input channels, and devices added to the map. Live view and
playback are only available for video channels.

e Hot zone: A map on a map. You may add hot spots on a hot zone.

Map Configuration

Add a Map

Click E-map on the control panel, and then click . PNG, BMP and JPEG images are

allowed. The added map appears on the page and on the Map Resources list on the left.
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Map

&l Picture Management (5) (D& Add HotZone || & Edit || T Delete

m- R IPC

206.10.252.134

206.10.252.163

206.10.252.176

You can:

e Change the map scale: Use the scroll wheel or click the zoom buttons (1) to zoom in or out.

o Eagle eye: Drag on the yellow area (2) to view details on the map (or drag map directly).

e Add hot spots (3): Drag devices, video channels, alarm input channels to intended positions on
the map. See Add a Hot Spot for details.

e Add hot zones (4): Add a map on the map. Up to 7 layers of maps are allowed. See Add a Hot
Zone for details.

e Manage pictures (5): Add or delete maps. Deleting a map will also delete all hot spots and hot
zones on it.

e Edit map resources (6): Edit map name, and change the icon color of hot zones.

e Filter map resources (7): Choose to display video channels, alarm input channels or devices on
the map.

Add a Hot Spot

Add hot spots so you can quickly locate them on the map when any event occurs. Hot spots include

video channels®#, alarm inputs and devices 5, Right-click a hot spot to change color or delete
it from the map.
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Map

[l Picture Management & Add Hot Zone & Edit W Delete |+ Video Alarm Input Device

& i

When adding a device hot spot, you can also add video channels and alarm input channels under it.
The channels and the device will appear together on a hot zone on the map. You need to choose a
map for the hot zone. Follow the steps as shown below:

Add Map Resource

2

Add Map Resource
SOuUrces Aftribute

Map Name ] Ilcon Color  Green @

map2

Previous Add@ Cancel

@ Next Cancel

Add a Hot Zone

Follow the steps to add a hot zone.
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Map

=4l Picture Management @ [&7 AdaHotZone & Edit i Delete v Video Alarm Input

&

m-;LIPC

L 20610252134
H Map Name |:and@ Icon Color ~ Green @

@ Add Cancel

The hot zone is displayed as an icon on the map and opens when you double-click it. Right-click a hot
zone to change color or delete it from the map.

Map Operations

After you complete the configuration, click the Map tab to use the map. You may view live video
from hot spots, handle alarms, etc.

Locate a Hot Spot or Hot Zone on the Map

Click the Locate button to locate a hot spot or hot zone on the map.

Edit Map

View Live Video from a Hot Spot

Double-click a video channel hot spot on the map to view live video from it. Up to 4 cameras are
allowed. Use the window toolbar as needed.
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EditMap

Map Resources H [ Select || [ CloseAl | A% ClearAlarm | v Video v Alarminput v Device
1_IP Camera 01
5.006_IP Camera 06
= 9
5.009_IP Camera09 N~ \ ~
)
arminput 01 /
arminput_02 J R

3.0.134 1 Alarminput 03

Click the Select button, and then drag on the map to select hot spots. Choose to play live or recorded
video from the selected hot spots.

B 5065275009 IP Camera09

Live View Playback

Handle Alarms

When an alarm occurs, the corresponding hot spot flashes red on the map. If the hot spot is on a hot
zone, the hot zone flashes red. Right-click the hot spot to play live or recorded video, view alarm info
or clear the alarm.
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View Hot Zone

To view a hot zone, click the hot zone map on the Map Resources list on the left, or double-click the
hot zone icon on the map.

Edit Map

Close 811 || gl Cle an | v \Video  + Alarminput ¥ Device

Click the main map on the Map Resources list to return.

13 Audio

Audio services include audio, two-way audio and broadcast. Two-way audio cannot work at the same
time with audio or broadcast, which means, starting two-way audio will stop audio or broadcast, and
vice versa.

Note: Broadcast is not available on Mac OS.

63



Audio

When live video is playing, cIick in the window toolbar to turn on audio from the camera. The

audio is one-way from the camera to your PC and it stops when live video is closed.

Note: Turning on audio for another camera will turn off audio from the current camera.

Two-Way Audio

Two-way audio is audio communication between a device (camera or NVR) and your PC. Both the
device and the PC shall be connected to audio input and output devices.

Note: Two-way audio is available to one device at a time.

Two-Way Audio with a Camera

Double-click the camera or drag it to the window on the right. When two-way audio is started, the
audio channel symbol changes (1), the two-way audio symbol flashes in the window's upper right
corner (2), and a hint appears indicating two-way audio is in use (3).

During two-way audio, you can adjust sound volume (4)(5) or stop two-way audio (6).

@ NOTE!

You may also start two-way audio with a camera (camera only) by cIickingin a live view
window.
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Two-Way Audio with an NVR

On the Two-way Audio tab, double-click the NVR or drag it to the window on the right. When
two-way audio is started, the audio channel symbol changes (1), the two-way audio symbol appears
at the window center (2), and a hint appears (3) indicating two-way audio is in use.

During two-way audio, you can adjust sound volume (4)(5) or stop two-way audio (6).

Broadcast

Broadcast is one way from your PC to cameras.

1.

Click the Broadcast tab. Select audio channels from the left-side list. You can:
Select audio channels one by one.

Select an NVR or an organization to select all audio channels under it.

Click Add. The selected audio channels appear on the broadcast list on the right.

After all the channels are added, click to start broadcast.
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After broadcast is started, you can:

e Add more audio channels: Select audio channels on the left-side list (1) and then click Add.
Broadcast starts automatically for these channels.

U
e Adjust sound volume (2) or click Bl to turn off the microphone.

e Delete audio channels from the broadcast list: cIickm (3) to delete one by one; or select the

check box (4) and then click 11 Bl (5) to delete in batch. CIickingn will select all channels in

the broadcast list.

e  Stop broadcast: click n or close the Audio page.

@ NOTE!

Currently, broadcast to an NVR is not available.

14 Alarm Configuration

Configure action(s) to trigger when an alarm of a certain type occurs at a specified source; view
alarm records and handle alarms.
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Configure Alarm-Triggered Action

Alarm configuration includes the configuration of alarm source, alarm type, device to link, and action
to trigger.

Click Alarm Configuration on the control panel and then follow the steps.

Example:

1. Click a tab according to the alarm type you want to configure. Take Camera Alarm for example.

e Camera alarm: includes camera online/offline, event alarm and VCA alarm.

e Device alarm: includes device online/offline, disk online/offline, high/low temperature, etc. For
DX devices, the following alarm types are available: fan failure, LED distribution box high
temperature, LED distribution box smoke alarm, fan failure cleared, LED distribution box high
temperature cleared, LED distribution box smoke alarm cleared, high/low temperature cleared.

2. Select an alarm source. The alarm source will trigger the configured actions.

3. Select an alarm type. An alarm of the specified type will trigger the configured actions. If you
choose face recognition match or not match alarm, make sure the monitoring task has been
configured (See Monitoring Task).

4. Configure alarm parameters.

For the following alarm types, you need to click Configuration to access the device's Web interface

and complete configuration first: motion detection, tampering detection, alarm input, audio

detection, intrusion detection, cross line detection, face detection, defocus detection, object left

behind, object removed, human body detection.

Take motion detection as an example, you need to make sure motion detection is enabled, detection

area is specified, and arming schedule is configured.

5. Click the Trigger Actions tab.

6. To receive an email alert when an alarm occurs, select the check box and complete email
configuration (see Client Configuration).
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9

Click Add. A dialog box appears. Select the device(s) to link and then click OK. The linked
device(s) appear on the list. The device(s) will be triggered to perform the specified action(s)
when an alarm of the specified type (step 2) occurs at the specified source (step 1).

Configure actions to trigger:

Alarm-triggered live view: An alarm will trigger a pop-up window playing live video from the
camera.

Alarm-triggered preset: An alarm will trigger the PTZ camera to rotate to the preset. The presets
in the list must be configured beforehand.

Alarm-triggered output: An alarm will trigger the camera to output an alarm and trigger an
action by a third-party device.

Alarm-triggered video wall: An alarm will trigger the video wall to play live video from the

camera. You need to complete video wall configuration first. Only one camera can be selected.

Click Save.

@ NOTE!

In order for alarm-triggered live view to take effect, click B in the bottom left corner of the GUI
and select Display Link Video.

Triggering live video from multiple cameras may cause high CPU usage of your PC and may therefore
affect other services.

View Alarm Records

Click Alarm Records on the control panel to view alarm records, acknowledge alarms, and export

alarm data to your PC.

Latest Alarm

The Latest Alarm tab list alarms reported since your current login and refreshes automatically.
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Tips:
You can:
e Sort records in ascending/descending order by clicking a header (e.g., Alarm Time).

e Acknowledge alarms: Select (or double-click) an alarm and click Acknowledge. Acknowledged
alarms are moved to the History tab.

e Click to turn on/off alarm sound.

e Click n to play an alarm video. The length of alarm video is configurable in client configuration
(Operation > Alarm > Stop Playback After and Start Playback Before).

e Click n to select/deselect all the alarms displayed.

e Click the Latest Alarm button (ﬂ) in the lower left corner of your GUI. On the page displayed,

you can turn on/off alarm sound, select/deselect Display Link Video to enable/disable
alarm-triggered live video, or double-click a record to display the full Realtime Alarm tab.

Latest dlern €  + Display Link Video

[ 7
e Click the Alarm-triggered View button (lsid)) to view alarm-triggered live video.

Alarn Info
5] . Alarn Type Mlarm Time

-~
B1 Zone D,f’,"“’" ... 2018-09-10 15:21:53

Mot
B1 Zone etents | 2018-09-10 15:14:29

B1 Zone Motion —  518.00-20 145132

B1 Zone - . 2018-09-10 13:33:01

-~
B1 Zone D,f’,"“’" ... 2018-09-10 13:28:11
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Tips:

The window toolbar is available (see Live View Window Toolbar).

Lock Screen: When this option is selected, the current window layout (e.g., 4-window layout) is
locked, and it does not change as new alarm-triggered live video occurs.

Lock Current Live View: When this option is selected, the current live video will not be replaced
by new alarm-triggered live video.

Live video stops when the set play time is over (see Configure Alarm-Triggered Action). You can
play the video again by double-clicking the alarm record in the top left area.

Click the button in the lower left corner to open the alarm records page.

Alarm level and corresponding alarm types:

Alarm Level Alarm Type

Level 1 Manual alarm

Device offline, motion detection started, alarm input started, cross line
detection, intrusion detection, face detection, audio detection started, defocus
detection started, scene change detection, auto tracking, tampering detection
started, disk abnormal, disk offline, array damaged, array degraded, face

Level 2 - -, . :

eve recognition match alarm, face recognition not match alarm, object left behind,
object removed, human body detection, video loss started, high temperature,
low temperature, fan failure, LED distribution box high temperature, LED
distribution box smoke alarm.

Level 3 Device online, disk online.

Level 4 Reserved.

Motion detection ended, alarm input ended, auto tracking alarm cleared, audio
detection ended, tampering detection ended, array back to normal, video loss
Level 5 ended, high temperature cleared, low temperature cleared, fan failure cleared,
LED distribution box high temperature cleared, LED distribution box smoke
alarm cleared.

History Alarm

All alarms, including latest alarms and history alarms, can be retrieved on the History tab.
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Alar

Hlarm Madn Type  ALL

Karm Status | All cknoy #larn Level Filter evel 3 v Level 4l + Level 5

You can:

e Set search conditions. Click Reset to reset search conditions.

e Click a header (e.g., Alarm Time) to sort records in ascending/descending order.
e Choose the number of records displayed per page.

e Double-click a record to view details. Alarm Time is your PC's system time when the alarm
occurs, and Device Time is the device's system time when the alarm occurs. The times can be
different. You will also find a time difference if your PC and the device belong to different time
zones.

Alarm Details

Alarm Type

Device Name

Alarm Time

Device Time

e Select an alarm and click Acknowledge to acknowledge it.

e Click n to select/deselect records displayed on the current page.

e Click Export to export search results to your PC as a CSV file. Use Microsoft Excel to open it.

1 5 Operation Logs

Click Operation Log on the control panel to query logs and export search results to your PC. Log
information includes username, operation details and result.
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2018-09-10 15:23:24

2018-09-10 15:23:2

2018-09-10 15:23:21

2018-09-10 15:23:20

2018-09-10 15:23:20

2018-09-10 15:23:2

2018-09-10 15:23:18

2018-09-10 15:23:16

-09-10 15:23:16

2018-09-10 15:23:16

2018-00-10 1593

You can:

User admin st

User admin

User admin

User admin

User admin

User admin

User admin

User admin

stop

stop live view, operation result: succeeded

stop live view, operation result: succeeded

start live view(C1), operation result: succeeded

start live view(C3), operation resuit: succeeded

st ), operation

w, operation result: succeeded

in stop live view, operation result: succeeded

nin ton live view Anaration recilt: cicrme dAnd

* Por Page

Set search conditions. Click Reset to reset search conditions.

Click a header (e.g., Log Time) to sort records in ascending/descending order.

Choose the number of records displayed per page.

Double-click a record to view details.

Click Export to export search results to your PC as a CSV file.

16 Client Configuration

Click Client Configuration on the control panel to configure the following parameters.

Parameter Description
e Short Delay: Video delay is minimized, though video
Processing quality may not be satisfactory.
Mode e Fluent: Video fluency takes priority, and video delay
may exist.
e Adapt to Screen Layout: When this option is
selected, the client chooses a stream type
Audio & Video according to the number of windows:
Video Windows > 16: Third stream
Stream Type 4 < Windows <16: Sub stream
Windows < 4: Main stream
e Use Default Stream Type: Choose the main, sub or
third stream.
Display Mode | Set according to the display capability of your PC.
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Parameter

Description

Transmission protocol for a camera to send video data
to the display window. The changed setting takes
effect at the next startup of the software.

Stream
Transmission | Note:
Protocol e TCP is recommended in poor network conditions.

e For UDP, make sure the software is not blocked by

the firewall.
e Selected: When you maximize a live view window

Play Main by a double-click or using the shortcut menu, the
Stream in system automatically switches to the main stream if
Maximized it is not the current stream type; and when the
Live View window restores, so does the stream type.
Window e Not selected: Maximizing a live view window does

not change the stream type.
Enable

Shortcut PTZ
Control

When enabled, shortcut PTZ control is available.

Enable VCA | When enabled, VCA rules display on the live video of

Rule the camera that supports this function.

When enabled, the software can start stream for more

Enable GPU | cameras.

Mode The supported encoding formats (e.g., H.264, H.265)

are displayed when this option is enabled.
e Auto: Save snapshot(s) in specified format to the
specified path.

Snapshot .

Mode e Manual: In this mode, user can select the
snapshot(s) to save, set the path and format, and
enter remarks (for JPEG only).

Continuous

Snapshot Time interval between two snapshots.

Interval

Snapshot Conti
ontinuous Number of snapshots to take every time.
Snapshots
Choose the format of snapshots taken to be saved on
your client computer:

Snapshot e BMP: Save snapshots without compression. It takes

Format more space than JPEG.

e JPEG: Snapshots are compressed to save space at
the expense of reduced image quality.

D

Rown(ljgaded Format and save path of downloaded recordings.

Recording ecording
Local Format and save path of local recordings.
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Parameter Description
Recording Set the recording policy when recording space is used
up:
e Overwrite: Earliest recordings will be overwritten
by new recordings when space is used up.
e Stop: Recording stops when space is used up.
Recording space: The disk space used to save
recordings.
Note:
It’s recommended to set at least 2GB recording space.
Recording file size: The size of a single recording.
When enabled, you will automatically log in to LTS
Ena'ble AUto | pr5.\s Station after you start the software.
Login to LTS . . )
Pro-Vs If Enable Auto Login to Windows is enabled at the
Stati same time, the software will automatically start after
Startup ation ; ;
the computer accesses the Windows operating system.
Enable Aut . . . .
Lcr:;ine utg When enabled, automatically log in to Windows with
Windows the provided username and password at startup.
Save
Operation Retention period for operation logs.
System Log For
Log
Save Alarm . .
Retention period for alarm logs.
Log For
|
mpqrt . Import configurations from a configuration file.
Configuration
Maintenance
Export . . .
) . Export configurations to save as a file.
Configuration
Enable Alarm | If enabled, you can custom alarm sound duration and
Sound set different sounds for different alarm types.
Alarm
Start Length of video before/after the alarm time for
Operation Playback playback. Use these settings to customize the length of
Before/After | alarm video that plays on the Alarm Records page.
Service Enable Auto | If enabled, the software syncs the PC's system time to
Time Sync cameras at the synchronization interval.
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Parameter

Description

Required for alarm-triggered email (see Configure Alarm-Triggered
Action). The specified email address(es) will receive an email when an
alarm occurs.

e Encryption Type: choose the encryption type of email transmission.

Email . .
e Sender: Email address used to send emails.
e Recipient: Email address used to receive emails.
Tip: Use the sender address as the recipient and click Send Test Email
to make a test.
Temperature . . .
Unitp Choose Celsius or Fahrenheit as the temperature unit.
Mask Enable/disable mask detection. When enabled, the
. number of people not wearing a mask is displayed in
Detection .. . o
Face Recognition > Realtime Monitoring.
Enable/disable abnormal temperature detection.
Abnormal .
When enabled, the number of people with an
Temperature . . .
. abnormal temperature is displayed in Face
Detection . . T
Recognition > Realtime Monitoring.
Abnormal
The system reports an alarm when the temperature
Temperature measured is higher than the threshold
Epidemic Threshold & ’
control ]
When enabled, the alarm will sound when an
abnormal temperature or a person not wearing a mask
Alarm Sound | . P P &
is detected. Make sure you enable Abnormal
Temperature Detection or Mask Detection first.
When enabled, an alarm window will pop up when an
Pop-up Alarm | abnormal temperature or a person not wearing a mask
Window is detected. Make sure you enable Abnormal
Temperature Detection or Mask Detection first.
When enabled, an alarm email will be sent when an
. abnormal temperature or a person not wearing a mask
Send Email .
is detected. Make sure you enable Abnormal
Temperature Detection or Mask Detection first.
Configure parameters to be displayed on the Realtime Monitoring,
. Alarm Records, and Pass-Thru Records tabs in the Face Recognition
Attribute . . .
Display module. All parameters are displayed by default. You can hide certain

parameters on these tabs and still view all parameters in the Details
window.
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17 User Management

=

Click User Management on the control panel to add, edit or delete users.

Use the default username/password (admin/123456) to log in. "admin" is the super administrator
and cannot be deleted.

1.

To add a user, click Add:
Administrator: Only admin can add administrator. Administrator has all permissions by default.

Operator: Admin or administrator with user management permissions can add operators. An
operator has no permission by default.

To assign permissions, specify permissions on the left. For some permissions (e.g., Live View),
you need to select device(s) on the right.

To edit a user (username, password, permissions), double-click the user on the list; to delete
user(s), select and click Delete.

NOTE!

Menus may be grayed out or hidden for lack of permission. Contact admin if necessary.
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